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 One Stop Shopping for Dev Info: 
http://agileappslive.info/wiki/Developers_Index  

◦ Java APIs & Cheatsheet 

◦ JavaDocs 

◦ Rest APIs & Cheatsheet 

◦ JavaScript APIs + jQuery 

◦ SQL Browser, Syntax, & APIs 

◦ Lots more… 
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o Search is your friend… 

http://agileappslive.info/wiki/Developers_Index
http://agileappslive.info/wiki/Developers_Index
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 Fields:  
◦ Date/Time & Currency (localizable) 

◦ Formulas 
… 

 Forms (defaults, interactive builder) 

 Validations (field/expression comparison) 

 Rules, Processes & Web Services, SLAs 

 Indexes 

 Record Locators 

 DB Configuration & access 

 More ... 
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 “JSP” Page 
◦ = HTML + Java Code 
◦ Interact with the Platform 
◦ Work with your data 

 

 JSP Basics 
◦ <% … code… %>   -- do something 
◦ <%=variable %>    -- insert data 

 

 Conditionals and Loops 
◦ <% if (…) { %>   <% for (item:List) { %> 

     … HTML …       … HTML … 
 <% } %>   <% } %> 
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 Visit the URL (https://.../networking/pages/xyz.jsp) 

(no context—just the page) 

 Web Tabs 
(appears like any other tab in the application) 

 Dashboard Widgets (display data & graphics) 

 Sites 

 Custom Forms 

 Custom Lookups 



 Application Architecture 
http://agileappslive.info/wiki/Application_Architecture 
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http://agileappslive.info/wiki/Application_Architecture


 Add libraries (e.g. A 3rd party rules engine, or existing libraries 

that integrate w/external systems or with custom web services) 
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◦ java.util.HashMap (valueMap) 

◦ com.platform.api.Parameters (params) 
      (used by all platform APIs) 
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 valueMap = 
   controllerResponse 
    .getData() 

Parameters 
(action) 

HashMap 
(control ) 

Controller Class 
 

execute(Parameters params) 
    cr = new ControllerResponse 
    … 
    cr.setTargetPage(next page) 
    valueMap = new HashMap 
      …(add values)… 
    cr.setData(valueMap)  
    return cr 

Page 
(HTML / JSP) 

HTML Form (post) 
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 99% in the Functions.class 
http://agileappslive.info/wiki/download/javadocs/  
 

 Going In: com.platform.api.Parameters 
◦ Parameters params = Functions.getParametersInstance();  

 

 Coming Back Out: com.platform.api.Result 
◦ Failure: getCode() < 0                 -- getMessage() for info 

Search Success: getCode() >= 0  -- #of items returned 
Other Success: getCode() == 0 
 

◦ Exactly one value (getRecord)  a Parameters object: 
   Parameters result_params = result.getParameters(); 
 

◦ One or more (search)  A list of Parameters objects: 
   ParametersIterator it = result.getIterator(); 
   Parameters result_params = it.next();  
 

◦ Controller: Put Result values into a HashMap for the JSP page 
 

http://lj.platformatyourservice.com/wiki/download/javadocs/
http://agileappslive.info/wiki/Application_Architecture
http://agileappslive.info/wiki/download/javadocs/


 In an attempt to improve clarity… 
 

◦ valueMap = HashMap instance passed to a Page 

◦ page_control = passed to a Page in a valueMap 
 

◦ params =Parameters instance passed to an API 

◦ page_action = passed from a Page in the params 
 

◦ result = Result values passed back from an API 

◦ result_params = Parameters object from the result 
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 Hands On 
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 Simple “Mailing List” object 
 

 
 
 

 
 

 Fields: contact_name, contact_email 
 

 Functional Spec 
◦ Add new name/address pairs to the list 
◦ Don’t add if the email address already exists 
◦ Give user a chance to update the name 
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JSP Page Java Controller 

Email already exists! 

18 

Update the record 

Add 

update_query 

Update 

updated 



 Login:  
◦ https://{yourDomain}.agileappslive.com    

◦ Supply Username & Password 
 

 Setup:  
◦ {gear} >Developer Resources  
◦ Developer Configuration > [Edit] 

 Namespace - the company package name  (“myCo”) 
    (You define subspaces when you add classes) 

 Debug Log Level – how much info you see 
◦ Debug Log (end of sidebar) 

 

 Full Instructions 
◦ http://agileappslive.info/wiki/ 

              HowTo:Create_a_JSP_Page_and_Java_Controller 
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http://agileappslive.info/wiki/HowTo:Create_a_JSP_Page_and_Java_Controller
http://agileappslive.info/wiki/HowTo:Create_a_JSP_Page_and_Java_Controller
http://agileappslive.info/wiki/HowTo:Create_a_JSP_Page_and_Java_Controller
http://agileappslive.info/wiki/HowTo:Create_a_JSP_Page_and_Java_Controller


◦ {gear} > Developer Resources > Pages > New Page 

◦ Name: AddUpdateYOURNAME.jsp (extension, no _’s) 

◦ Header Files: Yes (so the page can appear as a tab) 

◦ Copy content from 
http://agileappslive.info/wiki/download/training/AddUpdate.jsp 

◦ Personalize debug msgs, namespace, & target Class 
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http://agileappslive.info/wiki/download/training/AddUpdate.jsp


 Obtaining values passed by controller 
◦ java.util.HashMap valueMap = 

        (java.util.HashMap)controllerResponse.getData(); 
 

 Form display controlled by passed values 
◦  <% if (page_control == "record_added" ) { %> 

       . . . 
 

 Form contents passed as name/value pairs 
◦ <input type="text“ name="contact_name"/> 

◦ <input type=“submit“ name=“action“ value=“Update"/> 

◦ <input type=“hidden“ name=“record_id"/> 
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◦ {gear} > Developer Resources > Classes > [New Class] 

 
 
 
 
 
 
 
 
Package: mailinglist 

◦ Name: AddUpdateController_YOURNAME (no extension) 

◦ [Next] 
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 Copy content from 
http://agileappslive.info/wiki/download/training   
    --AddUpdateController.java  

 Personalize the namespace, class, messages, & target page: 
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http://lj.platformatyourservice.com/wiki/download/training
http://agileappslive.info/wiki/download/training
http://lj.platformatyourservice.com/wiki/download/training


 Getting Parameters passed by a Form 
 
 

 Specifying target page 
 
 

 Passing Values 
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 SQL Search in the find() function 
 
 

 Other APIs in add() and update() functions 
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 execute() method = “Dispatch Table” 
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 Visit the page: 
https://{domain}/networking/pages/AddUpdate_YourName.jsp 

 

 Experiment 
◦ Add a record, and view the data in the GUI (refresh) 

◦ Update a record (refresh)  

◦ Cancel an update 

◦ Add the page as a Web Tab 
http://agileappslive.info/wiki/Pages#Display_a_Page_as_a_Web_Tab 
 

 Learn More 
◦ http://agileappslive.info/wiki/ 

 Lab_Exercises#Basic_Programming_Exercises (from ground up) 

 HowTo:Create_a_JSP_Page_and_Java_Controller (this application) 
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https://108.166.77.226/networking/Pages/AddUpdate_YourName.jsp
https://108.166.77.226/networking/Pages/AddUpdate_YourName.jsp
https://108.166.77.226/networking/Pages/AddUpdate_YourName.jsp
http://agileappslive.info/wiki/Pages#Display_a_Page_as_a_Web_Tab
http://agileappslive.info/wiki/Pages#Display_a_Page_as_a_Web_Tab
http:///
http://agileappslive.info/wiki/Application_Architecture
http://agileappslive.info/wiki/Lab_Exercises
http://isv.platformatyourservice.com/wiki/
http://agileappslive.info/wiki/Lab_Exercises#Basic_Programming_Exercises
http://agileappslive.info/wiki/HowTo:Create_a_JSP_Page_and_Java_Controller
http://agileappslive.info/wiki/HowTo:Create_a_JSP_Page_and_Java_Controller


 Go to the Log 
◦ {gear} > Developer Resources > Debug Log (refresh) 

 

 Edit the view (hover over the wrench icon) 

 
 
 

 Filter tab:  Field          Operator        Value 
                 Type           starts with     YourName 

 [Save As] 
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 Uncomment to add HashMap to Debug Log: 
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 See the entry in the Debug Log (refresh) 
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 When creating a new class: 
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 Logger utility class 
/javadocs/com/platform/api/Logger.html  
 

 Log messages at specified levels 
◦ Debug, Error, Fatal, Info, Trace, Warn 

 

 More: 
http://agileappslive.info/wiki/Java_Debugging_Tips  

http://agileappslive.info/wiki/Debug_Log#Working_with_the_Debug_Log   
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http://agileappslive.info/wiki/Java_Debugging_Tips
http://agileappslive.info/wiki/Java_Debugging_Tips
http://agileappslive.info/wiki/Java_Debugging_Tips
http://agileappslive.info/wiki/Debug_Log#Working_with_the_Debug_Log
http://agileappslive.info/wiki/Debug_Log#Working_with_the_Debug_Log


 Limits on Resource Usage 
◦ Memory / String Heap / Statements executed 

 

 Defaults built into the installation  
 

 Can be set for each tenant (on-premise) 

◦ (helpful if you’re billing by usage) 

 

 Can be disabled (on-premise) 

◦ not recommended, except for development 
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 {gear} > Objects > Mailing List 

 Forms > Default Layout 
◦ Field scripts (Hover -> Scroll icon: on change, on focus)  

 > [Form Scripts] > [Edit] 
◦ On Load, On Save, Functions 

 On Save Script: 
◦ if (getTextFieldValue(_sdForm, "contact_name") == 

"") { 
   alert("Name is required");  
} 

 Test it 
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 jQuery library 
◦ Built-in (best way access & modify the DOM) 

◦ can also use jQuery components 

◦ and JSON functions 

 JavaScript APIs 
http://agileappslive.info/wiki/JavaScript  

 AJAX 
◦ Invoke REST APIs from JavaScript 

◦ Get back XML or JSON, as desired 
◦ …/wiki/HowTo_Guides#Build_Custom_Web_Pages 
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http://lj.platformatyourservice.com/wiki/JavaScript
http://agileappslive.info/wiki/Application_Architecture
http://agileappslive.info/wiki/JavaScript
http://agileappslive.info/wiki/HowTo_Guides
http://agileappslive.info/wiki/HowTo_Guides
http://isv.platformatyourservice.com/wiki
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 Firefox > Tools > Poster (plugin) 

 

 

38 

 XML Response 
   (default) 
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/rest/execSQL?sql=SELECT%20*%20FROM%20Mailing_List&alt=json 

Spaces 
encoded 



 import com.platform.api.utility.Base64Codec; 
  
String sql = "SELECT * FROM Mailing_List" 
 
Base64Codec codec = new Base64Codec(); 
String encodedSQL = codec.encode(sql); 
 
String base_url = "…/rest/execSQL?sql=" 
String url= base_url + encodedSQL; 
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com.platform.api.utility.Base64Codec; 
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 Code completion, error reporting, highlighting 

◦ Download & installation instructions: 
   http://agileappslive.info/wiki/Eclipse_Plug-In  

◦ Create a Project (give name, URL, username, password) 

File > New > LongJump Project 

◦ View 
Window > Open Perspective > Other > LongJump 

◦ Modify Login Settings 

Rt click (project) > Properties > LongJump Authentication 

◦ Synchronize 
Rt click (project, folder, or file) > LongJump Server > 

Save on Server  -  Refresh from Server  -  Delete from Server 

Refresh Libraries (for new APIs after a platform upgrade) 
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http://lj.platformatyourservice.com/wiki/Eclipse_Plug-In
http://agileappslive.info/wiki/Application_Architecture
http://agileappslive.info/wiki/Eclipse_Plug-In
http://agileappslive.info/wiki/Eclipse_Plug-In
http://agileappslive.info/wiki/Eclipse_Plug-In
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 NotePad++ for JSP pages (great highlighting) 
 --Use in conjunction with Eclipse Plugin 

 
 

 

 

 

 

 

 

 Built-in SQL Browser to test SQL statements 
http://agileappslive.info/wiki/SQL_Browser  

http://lj.platformatyourservice.com/lj90/SQL_Browser
http://agileappslive.info/wiki/Application_Architecture
http://agileappslive.info/wiki/SQL_Browser


 Poster (Firefox plugin) for REST exploration 
 

 FireBug (Firefox) or Dev’r Tools (Chrome) 

◦ GUI-select to view page components 

◦ View page interactions in the console 
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 Version-controlled files for pages & classes 

◦ Eclipse Plugin: platform  files 

◦ Tortoise SVN: files  shared repository 
 

 Use a Package to Create a Snapshot 
◦ Publish, download, & add date 

◦ Remove date to re-install 
 

 Sandboxes (production, Q/A, dev) 
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Resources 
◦ http://agileappslive.info/wiki/download/training/ 

     PlatformDevelopment101.pdf (this talk, code files) 
 

◦ http://agileappslive.info/wiki/ 

              HowTo:Create_a_JSP_Page_and_Java_Controller 
             (writeup) 
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http://agileappslive.info/wiki/download/training/
http://agileappslive.info/wiki/download/training/PlatformDevelopment101.pdf
http://agileappslive.info/wiki/
http://agileappslive.info/wiki/
http://agileappslive.info/wiki/
http://agileappslive.info/wiki/HowTo:Create_a_JSP_Page_and_Java_Controller

